A MESSAGE FROM DRU

Aren’t you glad that all of the Spring festivals are over? I know I am.

For those of you who haven’t held an iPad in your sweaty fingers yet, AND you missed the Apple Corps of Dallas’ iPad Presentation on the 10th, you really, really, really need to go over to one of the local Apple Stores and hold one in your hands and see it work. It really is quite spectacular.

Saturday night be alright for fightin’ if you’re Elton John, but if not, you might try Saturday night’s alright for lovin’. LoveSong plays at a new venue on Saturday April 17th. It’s called the Marcus Café. Incredibly delicious Italian food! Good prices. Dancing!!! And, of course, great music. So enliven your palate, put on your dancin’ shoes, and come over to 2701 Custer Parkway in Richardson. [Just south of Renner and Custer].

Click on the Marcus Café link to get directions and take a gander at the menu. Yummy! We take the stage at 6:30 pm and will be going ‘til 10 pm. Hope to see you there.

Thanks to all of you who showed up at our LoveSong Home Concert last Sunday. I know Dianne and I had fun, and it certainly looked as if the folks that showed up had fun too. We just might do this again in June (at the House of Dru’s)...on the patio.

There is a LOT of stuff going on and that’s reflected by this issue’s 11 pages. 11?!? Between the Opinion & Comments, and the new MacBook Pro Review, and just a lot of other stuff...well, you know. If you ask me it’s worth the read...but then again I’m biased.

Did everyone get their taxes filed? Well, everyone but me. But that’s why I have a CPA. I give him the printouts from Quicken and then it’s his worry.

----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------
Printing font samples from Font Book

Take Control of Fonts in Leopard

by Sharon Zardetto, Book Excerpt

Editor’s Note: The following article, which covers both Mac OS X 10.6 Snow Leopard and 10.5 Leopard, is adapted from Sharon Zardetto’s Take Control of Fonts in Leopard, a 227-page ebook that explains font locations, load order, Font Book, different installation methods, how to deal with duplicate fonts, and more. It is available for $15 from TidBits Publishing.

There are many ways you can preview your fonts in Leopard or Snow Leopard: with Quick Look in the Finder, for instance, or with one of Font Book’s choices (choose Sample, Repertoire, or Custom from FontBook’s Preview menu). But sometimes nothing beats printed versions of fonts so you can peruse your fonts the way most people will see them: on paper.

Font Book provides three different types of font-sample printouts (as seen in “Font Book’s Printed Samples” below):

- Waterfall: This traditional font-sample option prints lines of alphanumerics in ever-increasing size. You can choose to include font details (family name, kind, and so on) for each font, and specify which font sizes you’d like included.
- Repertoire: Be careful with this one, since it prints a grid of every glyph (character shape) in a font, and some fonts have thousands! You can set the glyph size.
- Catalog: This prints a sample of letters and numbers in a font. You can set the font size and choose to group typefaces under the font family’s name.

Font Book’s Printed Samples: From top to bottom, the samples are Waterfall, Repertoire, and Catalog.

Printing a sample is straightforward:

1. In Font Book, select the fonts you want printed. You must select them in the Font list; if you want to print an entire library or collection, click on its name in the Collection list, and then click in the Font list and choose Edit -> Select All (Command-A).
2. Choose File -> Print (Command-P). If the Print dialog is collapsed, expand it to its full size by clicking the expansion arrow to the right of your printer’s name.
3. With Font Book selected in the Print Options pop-up menu (it’s not labeled—it’s the one in the middle of the divider line just beneath the standard choices for paper size and orientation), choose a report style from the Report Type pop-up menu.
4. Set options for the report type you’ve chosen (font or glyph size, for instance).

Since the Print dialog includes a document preview, you can flip through the pages to see what you’re getting. Be sure to check the number of pages noted below the preview, in case it’s ready to print more than you expect.

For more control over what pages finally print (Dump that page with a single line of information! Get rid of those two fonts whose familiarity has bred great contempt!), use the PDF button in the Print dialog to open a PDF in Preview before printing, and use Preview’s capabilities of deleting and reorganizing pages in a PDF document before you print it.
Apple leads PC industry in profit share, analysts say

by Marco Tabini

Wondering why other computer makers suffer from Apple envy? Deutsche Bank may have an answer for you: its profits are higher—way higher—than any of its competitor.

According to a Business Insider article, the banking giant has aggregated numbers from the top ten PC makers in the world and determined that, while Apple only commands 7 percent of overall revenues in the PC market, its products account for 35 percent of the operating profits. (Operating profit represents the surplus generated by the difference between the sale price of a product and its cost; it doesn’t take into account things like taxes, interest payments, and depreciation.)

None of the other manufacturers on the list—which includes such giants as Dell, Hewlett-Packard, and Lenovo—comes even close to matching Apple’s five-to-one ratio between revenue and profit share, a fact which the article attributes to the fact that those companies need to pay a “Windows tax” in order to distribute Microsoft’s operating system installed on their products.

While the fact that hardware and software are tightly integrated in Apple’s platform undoubtedly affords them some economies of scale, however, one should also consider the fact that OS X doesn’t appear magically out of thin air. Apple needs to invest—and likely invest heavily—on developing and maintaining the operating system, and that’s not an inexpensive undertaking.

Apple’s success is probably due to a combination of factors, including a well-defined lineup of products with little overlap, the tight inventory control for which Tim Cook is famous, and the higher production quality that attracts buyers willing to pay a premium for what they perceive as superior craftsmanship.

This purchasing power makes Apple customers attractive to software developers, which might explain why the OS X software market is so vibrant despite a relatively small share of overall PC sales.

Apple Sells Over 300,000 iPads First Day

Apple announced that it sold over 300,000 iPads in the US as of midnight Saturday, April 3. These sales included deliveries of pre-ordered iPads to customers, deliveries to channel partners and sales at Apple Retail Stores. Apple also announced that iPad users downloaded over one million apps from Apple’s App Store and over 250,000 ebooks from its iBookstore during the first day.

“It feels great to have the iPad launched into the world—it’s going to be a game changer,” said Steve Jobs, Apple’s CEO. “iPad users, on average, downloaded more than three apps and close to one book within hours of unpacking their new iPad.”

Apple Updates MacBook Pro Line

Faster Processors, Next-Generation Graphics & Up to 10 Hours of Battery Life

Apple updated the MacBook Pro line with faster processors, powerful next-generation NVIDIA graphics and even longer battery life. The popular 13-inch MacBook Pro features the new NVIDIA GeForce 320M graphics processor for up to 80 percent faster graphics and a groundbreaking 10-hour built-in battery.* The new 15-inch and 17-inch MacBook Pro models feature Intel Core i5 and i7 processors and Apple’s new automatic graphics switching technology that toggles seamlessly between powerful NVIDIA GeForce GT 330M and energy efficient Intel HD Graphics processors.

“The new MacBook Pro is as advanced on the inside as it is stunning on the outside,” said Philip Schiller, Apple’s senior vice president of Worldwide Product Marketing. “With faster processors, amazing graphics and up to three more hours of battery life, the new MacBook Pro delivers both performance and efficiency.”

Continue on Page 9
Q: What’s gonna happen when I carry my new iPad through airport security? Will I get fingerbanged by the TSA? What’s the official iPad airport security policy? Their response simultaneously says very little, and very much.

A: “Laptop computers or electronics similar in size must be removed from carry-on baggage and placed separately in bins. Small and portable electronic items do not need to be removed from their carrying cases. If a Transportation Security Officer cannot resolve an item in carry-on baggage on the X-ray screen, it may require additional screening.”

Not a single mention of the iPad itself, but it seems to pretty clearly fall under “electronics similar in size” to laptops that require you pull it out of your bag. You could, I suppose, try to slip through, but you’re basically asking to get some of that “additional screening” action. So, the safe way to play it? Treat it like a laptop.

Q: Whatever happened to the version of Outlook Express that used to run on the Mac?

A: Microsoft’s mail program for the Macintosh, which appeared in 1998 with Internet Explorer 4.0 and Microsoft Office 98 for Mac, was a popular choice for years. Microsoft still has a version of it available for download, but there’s one catch — the software runs only on Mac OS 9 and on Mac OS X systems that can still run Mac OS 9 programs.

Microsoft’s last update to Outlook Express for Mac was in 2002, and the program seems to have given way to the built-in Mail program that comes with Mac OS X. But this does not mean that Microsoft is out of the Mac OS X mail-program business. The company has included its Entourage program for mail, contacts and calendars in the last few versions of Microsoft Office for Mac.

The days of Entourage are numbered, however. Microsoft announced last summer that the next version of its Mac Office software (scheduled to arrive by the end of this year), will include a version of Outlook written specifically for Mac OS X. This new Mac Outlook is expected to be on par with the Windows version of Outlook that anchors many corporate mail systems.

Q: I’d like to gift someone an app from the App store. Is that possible?

A: One of the biggest irritations and shortcomings on the App Store has been remedied. Apple has now integrated gifting into the App Store, a move which will likely bring significant additional revenue to developers around key holidays.

On the iTunes side, music gifting has become very popular since it was implemented, particularly related to music discovery among friends, and I believe that this behavior will continue into the application space as well.

Q: I never thought this would happen to me—I dropped my iPhone in the toilet! Eek! What to do? Blogger Erin Thompson reports:

A: “Last night I dropped my phone in the toilet, and it wouldn’t even turn on afterwards,” she writes. “I was at Video Isle whining about how I was going to have to buy a completely new iPhone, and there was a man there who just happened to work for AT&T.

“I asked him if I should try to blow-dry my phone, and he said: ‘Turn it off completely, put it in a bag of rice, and leave it there for a couple hours. The rice will absorb the moisture’.

“So, I went home, got out a bag of rice, and stuck my phone in there. I took it out about an hour later, tried to turn it on, and the screen kind of lamely flickered at me. But at least it was turning on, so I stuck it back in there. A couple hours later, before I was about to go to sleep, I took it out and turned it on… AND IT TOTALLY WORKED.”

We suspect this could also be the cure for a damp iPod, and we’re kind of curious if it could help an en-dampened digital camera. (Hint: We suspect rice and cheese mixtures won’t be appropriate).
Are You Using a “Sub-standard” App?

by Gene Steinberg

So Steve Jobs has thrown down the gauntlet. He is clearly sick and tired of applications that perhaps run decently on Macs and other Apple platforms but don’t take advantage of all the features. The media wants to suggest Apple is really at war with Adobe and other companies that use runtimes and cross-platform tools to create their apps. But is there anything wrong with that?

I realize most of this programming stuff doesn’t mean much to most of you, but consider your user experience. With Java, a programming method that was supposed to allow apps to function on loads of computing platforms, do you actually recall any that look good and work well? Any? Or do you end up with compromised garbage with poorly-formed user interfaces and erratic performance?

Large software developers, such as Adobe and Microsoft, generally use cross-platform development environments so they can basically write many of an app’s features once and then deploy them to the Mac and Windows after doing the requisite work to make them appear native to their target OS. At the same time, it means that those applications may not only have interface glitches but lack native capabilities.

Now Apple migrated to Intel processors four years ago. They have evangelized developers to support 64-bit processing, the better to maximize performance and, if need be, use larger amounts of RAM. Here in 2010, you look at the specs for Adobe’s forthcoming CS5, and find that just three apps in the suite truly support 64-bit. It would seem Adobe has tossed us a bone by offering that support for Photoshop, Premiere Pro and After Effects. Yes, those are the apps that are apt to benefit most, but what about support for Grand Central Dispatch for superior performance on today’s multiprocessor Macs, or OpenCL to harness the power of the most powerful graphics chips?

When you check the specs for Photoshop Extended, the high-end version, all Adobe tells you about enhanced capabilities is: “Some GPU-accelerated features require graphics support for Shader Model 3.0 and OpenGL 2.0.”

What about the reworked plumbing in Snow Leopard? Why isn’t Adobe addressing any of those features, other than token support for 64-bit? Do they not believe that the Mac content creators that form a hefty portion of the user base would somehow benefit from the best possible rendering speeds?

Or did Adobe saddle itself with cross-platform tools that make adding extra support for a custom OS feature more difficult? Or maybe, as some have suggested, Adobe took a gamble years ago to emphasize the Windows platform over the Mac. Despite the Mac’s resurgence, they have been slow to adapt.

That takes us to Flash, where Adobe’s new tool to port Flash apps to the iPhone platform will be stillborn come version 4.0 of Apple’s mobile OS. I suspect Adobe’s spin control machine is working overtime to paint this as an act of revenge on the part of Steve Jobs in his eternal efforts to maximize control.

But also consider what I just said, that using non-native compilers to build an app may provide compromised results that fail to support all of the custom features of a particular OS. Maybe that’s fine if you want to deliver the same stuff for the Android OS and iPhone. But what about the new multitasking capabilities for iPhone 4.0, and the other 99 new features? If apps don’t support those features, it hurts the platform because customers can’t use all the capabilities that Apple promises. It also hurts the apps themselves, because they deliver a sub-par user experiences.

That may have worked fine on the Mac, where Apple had to struggle to encourage developers to stick with the platform over the years, particularly after migrating to Mac OS X. Indeed, the original release of Mac OS X was delayed by several years because Apple was forced to build the Carbon environment to make it simpler for the largest developers, such as Adobe and Microsoft, to support the OS more easily and not have to redo all their apps, a prospect to which they objected.

In the real world, Carbon worked well enough, but as Mac OS X matured, Apple encouraged developers to migrate to Xcode’s Cocoa technology. The situation became all the more important when Macs moved from the PowerPC to Intel processors, and it’s essential if new apps have any hope to support Snow Leopard’s new features.

Returning to the mobile platform: Despite the complaints, it doesn’t seem that Apple’s tighter control has hurt sales in any meaningful fashion. It’s not as if loads of customers are moving to Android or Blackberry devices because Apple changed the terms of its developer agreement or has blocked Flash from the platform. Yes, the lack of Flash can be inconvenient, since you can’t get the full experience from loads of sites.

Continue on Page 10
Apple MacBook Pro (15-Inch, 2010 Version)

At first glance, you may not notice anything different about Apple’s latest line of MacBook Pros, introduced in April 2010. The new models, which feature 13-, 15- and 17-inch screens, sport the same sleek, minimalist design, the same keyboard, and the same multi-touch trackpad as the previous iteration. Even the ports haven’t changed. To tell the difference, you really have to get down and dirty and actually start using one of these new members of the MacBook Pro family. Once you do, you’ll see advancements in performance in a line of laptops that was already well ahead of much of its competition, and battery life that blows the competition out of the park.

We put a $2,199 MacBook Pro model, built around a 2.66GHz Intel Core i7-920 processor and a 15-inch screen, through our labs testing. The base-model 15-inch MacBook Pro costs $1,799 and features a 2.4GHz Core i5 processor and a 320GB hard drive; a $1,999 bump-up model has a 500GB hard drive and a slightly faster 2.53GHz variety of the Core i5. All three employ the same Nvidia GeForce GT 330M graphics processor, but with varying amounts of dedicated video memory (512MB in our test unit, 256MB in the other two). You’re also able to upgrade certain components on these base models singly on the Apple Store online.

Apple has also refreshed the 13-inch and 17-inch versions of its MacBook Pro. The base model of the 17-inch MacBook Pro is $2,299 and uses a Core i5 processor. (Upgrades in CPU and hard drive are available, with, for example, a Core i7-920 chip at a $200 premium.) The entry-level 13-inch model costs $1,199 (with a 2.4GHz Intel Core 2 Duo CPU and a 250GB hard drive), and a $1,499 model is available, too (2.66GHz Core 2 Duo, 320GB drive). Take note: With this generation of MacBook Pros, the base price of the 15-inch model has increased by $100 (a small amount considering the souped-up insides you’re getting). The 17-inch base price has decreased by $200, and the 13-inch base price stays the same.

On the outside, the 15-inch MacBook Pro is almost exactly the same as before. Design-wise, we think Apple was smart to approach the new line with the attitude that if it’s not broken, don’t fix it. The previous line of MacBook Pros was as stunning as it was stark, and the new line carries that torch onward. The silver case, dominated by an aluminum shell with just one seam around the underside, feels plenty solid. Nothing much mars the design of the MacBook’s body: On the top of the lid is a simple white Apple logo that lights up when the laptop is in use. And, well, that’s about it. The case snaps shut with a magnetic latch, making opening the lid easy without compromising the durability of the body.

Like the previous version, the ports are located on the left side of the chassis and include an Ethernet jack, a FireWire 800 port (backward-compatible with FireWire 400, 200, and 100), two USB 2.0 ports, a mini-DisplayPort connector (for attaching an external display), headphone and microphone ports, and an SD-card slot. Toward the front left of the chassis are indicator lights that allow for a quick look at remaining battery power. On the right side of the body are a security-lock slot and the opening for the slot-loading optical drive, which is a dual-layer DVD burner. As with previous MacBook lines, it doesn’t support Blu-ray discs.

On the keyboard deck is a generously sized, buttonless multi-touch trackpad with a glass surface. Instead of the two-button touch pad you’ll find on most other laptops, the entire trackpad on the MacBook Pro acts as a button, allowing you to press anywhere to enact a function; you use two fingers to right-click. One new feature on the trackpad is that if you swipe up or down with two fingers, you’ll continue to scroll through the page until it reaches the top or bottom, just as an iPad or iPhone works. We appreciate these touches that Apple keeps adding to further bridge its products together. We also discovered that you can even toggle in and out of full-screen mode when watching a DVD by pinching and pulling on the touch pad, a nice enhancement. We found the trackpad easy to get used to, especially since it functions much like the touch screen on an iPad or iPhone.

As with previous MacBook Pros, the trackpad also allows you to use a four-finger swipe to show your desktop, view all open windows, or change programs. Of course, the now-requisite multi-touch functionality is built in here as well. (This is the same as the touch features on an Apple iPhone or iPad, allowing you to zoom, rotate, and slide images around with two fingers.)

The 15-inch glossy screen on the model we tested has a native resolution of 1,440x900. Once you open the lid, you’ll also notice that little has changed in the design of the keyboard and multi-touch trackpad. The full-size keyboard comes with backlit keys, and it remains perfectly spaced and nicely responsive to the touch. An ambient-light sensor adjusts the key backlighting according to the brightness of the area where you’re working.

Continue on Page 10
Partition a drive without reformatting

One of my favorite Snow Leopard features is the ability to partition a hard drive WITHOUT having to reformat it first. As long as you’re not currently booted off that drive, you can plug it in, open Disk Utility and partition it without having to reformat it. I just did this recently on an external portable Firewire drive so that I could create a second boot partition for beta testing. It worked perfectly without losing the contents. YOU SHOULD ALWAYS BACKUP FIRST BEFORE DOING ANY WORK IN DISK UTILITY.

Multiple Time Machine Backups

Now you can have multiple Time Machine Backups. If you go to your Time Machine prefs and choose a different drive you can of course backup to it. However, if you later go back and set Time Machine to backup to the first drive Time Machine will pick up where it left off. This is great for creating offsite backups or going between two drives such as a Time Capsule at home and a portable drive on the road.

Use Font Book to check for damaged fonts

Weird things can happen including frequent crashes if you’ve got a damaged Font. You may never even know it if it’s a Font that you don’t use often. However, some Apps build their Font menus upon launch based on your installed fonts, so if one or more of them is damaged then you can experience issues. Luckily Font Book can check for damaged Fonts. Just select your fonts in Font Book and choose Validate Fonts from the File menu.

Turn off the translucent menu bar

One of the things that really annoyed me in early on in Mac OS X Leopard was the Translucent Menubar. I was extremely happen when Apple gave us the option to turn it off. However, it’s not obvious where to find it. Go into your System Prefs and choose Desktop & Screen Saver. Then you’ll see the checkbox and turn it off.

Zoom your screen

Whenever I’m doing a presentation to a large audience or recording my screen for a video, I like to Zoom in on elements that are hard to see. This always makes it easier on the eyes of my audience. You can turn this ability on in the Universal Access System Prefs as well as going into the Options to control the Maximum Zoom Level you’ll get with a single keystroke combination. Once it’s on you can zoom in by hitting Command-Option + and zoom out by hitting Command-Option -.

Screenshot to clipboard

There are several Mac OS X keyboard shortcuts to take screen shots. Command-Shift-3 captures the whole screen and Command-Shift-4 allows you to select part of the screen to capture. However, one of my favorite built-in shortcuts is Command-Control-Shift-4 which will allow me to select part of the screen and make the capture, but instead of capturing to a file on my desktop, it captures to the Clipboard instead. I can then just paste the capture into another application such as Mail.

Get your Mac’s Serial Number

If you ever need to call Apple Support chances are they are going to ask you for your Mac’s serial number. The placement of this serial number will be in different places depending on your Mac model. In most cases it will not be convenient to get to. Luckily you can do it without crawling around on the floor or turning your Mac upside down. Just choose About this Mac from the Apple menu and then just click the version of the Mac OS you have installed (ie. 10.6.2) and it will cycle through to your OS Build Number and if you click again it will show you your Mac’s serial number.

Share an Internet connection

If you are in a situation where you need to share your internet connection with others, you can actually turn your Mac into a mini AirPort base station. For example, let’s say you’re in a hotel or meeting room and you have an internet connection via Ethernet. You can actually share that connection with others or your other devices like an iPod touch or iPad by simply enabling Internet Sharing in the Sharing System Prefs. You can even secure your makeshift WiFi network with a password to prevent the world from jumping on.
Apple iPad: The Evolution of Home Computing

Techies may despise the lack of choice in a locked-down device like the iPad — but for the average consumer, that means “simplicity.”

by Kenneth van Wyk, PC World

I have seen the future of home computing, and it is the iPad. I’m convinced of it.

Yes, iPadurday has come and gone. Many of us have Wi-Fi iPads in our grubby little mitts. Early reviews have been mostly stellar. The device -- and more importantly, the software running it -- is superb, but certainly not perfect. And now we’ve seen Steve Jobs outline the next release of the operating system, iPhone OS 4.0. That’s all well and good, but largely secondary to my point.

I’ve discussed the app store model here a couple of times, and the security ramifications it carries. Well, let’s consider the iPad in that light, now that it has been released.

When I got my iPad, I immediately installed several software packages on it. Most of it was for entertainment (e.g., Netflix, ABC Reader), but I also installed a couple of apps that could at least ostensibly be used for business (e.g., Pages, Keynote). Each installation was simple: I ran the App Store application, found the tools I wanted, and clicked the purchase icon. Within moments, each package installed.

The installation process gave me absolutely no choice as far as where the software would reside on my iPad. In fact, I had no choices whatsoever beyond yes/no to purchase the apps. Once the apps were installed, I was able to get some of my Keynote presentations and Pages documents over to my iPad via an iTunes synchronization to my MacBook Pro. (The need to do it that way is a separate topic, discussed below.) But here too, I had absolutely no way of controlling or choosing where the documents were placed on the iPad. Once I synchronized the device, the documents appeared for their respective applications.

For many of my fellow techies, the words “lack of choice” are the kiss of death for a device like this. But for the average consumer, “lack of choice” can be interpreted as “simple,” by and large. And to get to the masses, simple never hurts.

So, what are the security ramifications here? Well, for one thing, there is no direct access to the file system without installing an app that gives you (limited) access to the iPad’s file system. Yes, there are ways to “jailbreak” your iPad and get to the underlying file system, but short of some malware doing that “for” them, that’s not something you’d find any consumers doing.

The apps themselves are at least somewhat sandboxed from one another. Data from one application isn’t generally available to other applications. And application storage can’t -- again, in the absence of jailbreaking -- be overwritten by another application.

Now, I’m not na?ve enough to believe that the sandboxing and compartmentalization won’t get broken by malware and such. It’ll happen, just as sure as the sun rises. Someone will find a vector to inject some malicious data into the device and get that data to execute, causing untold damage to the security architecture of the device.

But the application vetting process should, at least in theory, police some appropriate coding policies. Again, for consumers, that’s a good thing. All the software that is available to the consumer via Apple’s App Store has been vetted and signed. At a minimum, it must comply with Apple’s coding policies.

One highly controversial example of that policy in action is Apple’s exclusion of all Flash content. I’m not going to dive into that political firefight, but Flash does relieve the platform of at least some degree of control over what can and cannot run on the system. I have to believe that that was at least a motivating factor in excluding Flash from the iPad. There’s certainly no shortage of malware in the wild that has used malicious Flash content as its launch vector. I am one iPad consumer who is relieved and grateful to have it excluded from my device.

The result of all this is a platform that is simple, intuitive and highly usable for common home computing tasks. Consumer-friendly activities like viewing photos, listening to music and watching movies have never been simpler or better. I just loaded hundreds of photos of my new basset hound puppy onto my iPad, and I can’t imagine a more perfect platform to show her off to my friends and family than my iPad.

And, even though I am not an average consumer of high-tech devices, I have absolutely no need to understand the underlying organization and architecture of the iPad. The apps I’ve installed just plain work. How can that not be a boon to the consumers of the world?

Continue on Page 11
MacBook Pro, cont.

All 13-inch MacBook Pro models now include faster Intel Core 2 Duo processors, 4GB RAM, a 10-hour built-in battery and the new NVIDIA GeForce 320M graphics processor. With 48 processing cores, the new NVIDIA GeForce 320M is the fastest integrated graphics processor on the market, ideal for graphics intensive applications or high performance games. The 13-inch MacBook Pro is available in two configurations: one with a 2.4 GHz Intel Core 2 Duo and 250GB hard drive priced at $1,199; and one with a 2.66 GHz Intel Core 2 Duo and 320GB hard drive priced at $1,499.

The new 15-inch and 17-inch MacBook Pro models are up to 50 percent faster than the previous systems. Using Intel's state-of-the-art 32 nanometer process, Intel Core i5 and i7 processors integrate the memory controller and Level 3 cache for faster access to system memory. Hyper-Threaded technology improves data throughput by creating virtual processing cores, while Turbo Boost optimizes performance between the two processor cores, accelerating the system from 2.66 GHz to 3.06 GHz for intensive dual core tasks, and up to 3.33 GHz for single core tasks.

All 15-inch and 17-inch models include two graphics processors, the new NVIDIA GeForce GT 330M for peak performance and Intel HD Graphics for energy efficient operation. More than twice as fast as the GeForce 320M, the powerful new GeForce GT 330M provides incredibly smooth, crisp on-screen graphics for the most demanding 3D games, creative software and technical applications. Apple’s automatic graphics switching determines which graphics processor an application needs and switches instantly between processors to deliver peak performance and long battery life. Tightly integrated hardware and software allow the new 15-inch and 17-inch MacBook Pro to deliver 8 to 9 hours on a single charge.

The new 15-inch MacBook Pro is available in three models: one with a 2.4 GHz Intel Core i5, NVIDIA GeForce GT 330M and 320GB hard drive at $1,799; one with a 2.53 GHz Intel Core i5, NVIDIA GeForce GT 330M and 500GB hard drive at $1,999; and one with a 2.66 GHz Intel Core i7, NVIDIA GeForce GT 330M and 500GB hard drive at $2,199. The new 17-inch MacBook Pro features a 2.53 GHz Intel Core i5, NVIDIA GeForce GT 330M and 500GB hard drive for $2,299.

The MacBook Pro glass Multi-Touch trackpad now supports inertial scrolling, an intuitive way to scroll through large photo libraries, lengthy documents and long web sites. All MacBook Pros feature bright, LED-backlit wide-angle displays with a broad color gamut. The 17-inch MacBook Pro includes a high resolution 1920 x 1200 display, and the 15-inch MacBook Pro is now available with an optional high resolution 1680 x 1050 display. Customers can also upgrade their MacBook Pro with new 128GB, 256GB and 512GB solid state drives.

As the industry’s greenest notebook lineup, every Mac notebook achieves EPEAT Gold status and meets Energy Star 5.0 requirements, setting a new standard for environmentally friendly notebook design. Each unibody enclosure is made of highly recyclable aluminum and comes standard with energy efficient LED-backlit displays that are mercury-free and made with arsenic-free glass. Mac notebooks contain no brominated flame retardants, are PVC-free and are constructed of recyclable materials. Apple uses advanced chemistry, intelligent monitoring of the system and battery, and Adaptive Charging technology to create a notebook battery that delivers up to 10 hours of wireless productivity on a single charge and up to 1,000 recharges. The built-in battery design results in less waste and depleted batteries can be replaced for $129 or $179, which includes installation and disposal of your old battery in an environmentally responsible manner.

All Macs come with Mac OS X Snow Leopard, the world’s most advanced operating system, and iLife, Apple’s innovative suite of applications for managing photos, making movies and creating and learning to play music. Snow Leopard builds on a decade of OS X innovation and success with hundreds of refinements, new core technologies and out of the box support for Microsoft Exchange. iLife features iPhoto, to easily organize and manage photos; iMovie with powerful easy-to-use new features such as Precision Editor, video stabilization and advanced drag and drop; and GarageBand which introduces a whole new way to help you learn to play piano and guitar.

Thanks for taking the time to read this month’s newsletter.

Hope you enjoyed it. If you have any comments or suggestions for stories (or would even like to write a story ~ hint, hint, hint), please send them to me at: machelpdesk@tx.rr.com

Feel free to share this newsletter with a friend. The newsletter archives are located at: http://www.machelpdesk.com/page6a.html

Y’all come back now, y’hear.
Sub-standard App, cont.

By the end of the year, however, there
will be 100 million Web surfers who
have great demographics in terms of
education and income who won’t be
able to view Flash content. You can
see how fast sites are dumping Flash
and that trend will only accelerate

In fairness to Adobe, that company
may have spent a bundle to buy
Macromedia and acquire Flash, but in
the end, their content creation tools
can live long and prosper even if Flash
dies. And no, folks, I don’t for a
moment believe those new rumors that
Adobe might sue Apple over its change
of iPhone SDK terms, or perhaps the
decision to ban Flash. Sounds like
someone’s having a psycho fit.

MacBook Pro, cont.

You can upgrade to a higher-resolution
1,680x1,050 screen, with either a
glossy or an anti-glare finish, for an
extra $100 or $150, respectively. We
found the base model’s screen to be
more than adequate, displaying movies
and photos with vivid, accurate colors.
Artists might want to consider
upgrading to the high-resolution, anti-
glare screen, however, as we did see
considerable reflectivity when we toted
the machine around our offices.

Apple’s iSight camera lives in the
middle of the top of the screen bezel,
along with a camera-indicator light,
which lights up to warn you when the
camera is on. (That could save you
from embarrassing moments when
doing something you wouldn’t want
to be seen doing on camera.) The
camera performs commendably, as we
noticed very little refresh lag, and it
even worked well under low-light
conditions.

As we worked our way around the
MacBook Pro’s body, we finally noted
one so-small-you-might-not-notice-it
change. The part of the power adapter
that connects to the body of the
MacBook is now a silver cylinder,
instead of the white rectangle on
previous versions.

Inside the newest line of MacBooks is
where you’ll find all the new goodies,
and they boost not only performance,
but also graphics rendering. That’s
important for a line of laptops that has
a dedicated following of graphic
designers and filmmakers. In the 15-
and 17-inch models, the graphics
horsepower gets a huge boost with the
inclusion of the Nvidia GeForce GT
330M, a dedicated graphics processor.
(The 13-inch version uses Nvidia’s
integrated 320M video circuitry.) Also
incorporated into the 15- and 17-inch
models, though, is a power-efficient
integrated Intel HD graphics chipset,
and these laptops have been
engineered to switch automatically
between the two graphics chips,
depending on the situation.

The previous MacBook Pro line also
featured switchable graphics, but the
switching had to be done manually and
required logging out and then logging
back in. The graphics in the new line
switch intelligently on the fly,
depending on the program you’re
using. For instance, if you’re using
graphics-intensive video-editing
software, the more powerful
integrated Intel HD graphics chipset,
and these laptops have been
engineered to switch automatically
between the two graphics chips,
depending on the situation.

The previous MacBook Pro line also
featured switchable graphics, but the
switching had to be done manually and
required logging out and then logging
back in. The graphics in the new line
switch intelligently on the fly,
depending on the program you’re
using. For instance, if you’re using
graphics-intensive video-editing
software, the more powerful
integrated Intel HD graphics chipset,
and these laptops have been
engineered to switch automatically
between the two graphics chips,
depending on the situation.

And just in case you’re wondering why
Apple is using Nvidia graphics
hardware but not opting for Nvidia’s
Optimus technology (which also
activates discrete graphics
automatically, as needed), Apple told
us the reason is battery life. Nvidia’s
Optimus solution turns on the
dedicated graphics hardware in
addition to the integrated graphics
chip, not instead of it which, according
to Apple (and common sense), means
more of a drain on battery life, all else
being equal.

The other big boost is in the processor,
with Core i5 and Core i7 CPUs finally
coming to the MacBook line. (Core i5
and i7 chips are not available in the
entry-level 13-inch models, which
come standard with a Core 2 Duo chip,
nor are Core i3 CPUs available on any
of the MacBook Pros.) And the hard
drive is another area of flexible
customizability. You can upgrade any
of the models to a solid-state drive
(SSD), though it will certainly cost you.
A 128GB SSD costs an additional
$200 over the 5,400rpm 500GB hard
drive in our test model; a 256GB SSD
is an additional $650, and a 512GB
drive will break the bank at a $1,300
premium. For an additional $50, our
test configuration’s 500GB hard drive
is also available in a faster 7,200rpm
variety.

So what do all these upgrades mean to
performance? Not surprisingly, in our
test model, we saw a huge bump in the
MacBook Pro’s Cinebench 10 score,
thanks to its Core i7 processor.
(Cinebench measures processor
capability and taxes all available
processor cores while rendering a
standard test image.) Its score of 8,612
is a leap of almost 2,000 points over
the previous 17-inch MacBook Pro</a>
we tested, which featured a Core 2
Duo chip. Also, that score is nearly
double the average for mainstream-
class laptops (which we define as 15-
inch models).
MacBook Pro, cont

and it handily beat out slightly less expensive models like the $1,799 HP Envy 15 (which managed a Cinebench score of 7,602), the $1,499 Asus G51J-A1 (8,397), and the $1,249 Sony VAIO F-Series (7,975)—all of which could be seen as MacBook competitors. Perhaps more impressively, it spans the $3,756 Dell Latitude Z600 (3,201), which doesn’t come with an impressive processor but sure is expensive.

We didn’t see a change on our iTunes encoding test, which measures how fast the processor can convert a standard slate of 11 music tracks from MP3 to AAC format. Taking 3 minutes to complete the conversion task, this model came within 1 second of the previous 17-inch MacBook Pro. As we expected, we didn’t see as big a boost on this test as on the others (when comparing dual-core to quad-core chips, our iTunes test seldom highlights the advantage of extra cores), but this score is nonetheless extraordinarily fast compared with just about all laptops we’ve seen, barring a few high-end gaming machines.

Battery life is where the MacBook continues to wipe its competition off the board. In our highly demanding DVD rundown test, in which we loop a movie until the battery dies, the battery lasted an astounding 6 hours and 55 minutes. That time bests the last version of the MacBook Pro by almost two hours and is hours ahead of its nearest competitors. According to Apple, the battery in the 15-inch and 17-inch MacBooks can last up to nine hours if you’re performing light tasks, and it should support up to 1,000 recharges. Battery life on the 13-inch model is rated even higher, at 10 hours. That’s a nice perk, because replacing the battery means sending the whole machine off to Apple and paying $179 for a replacement cell. (Another replacement option: For the same price, if you call ahead, you can bring your MacBook Pro to an Apple Store Genius Bar and have the battery swapped out while you wait.)

iPad, cont.

Not all is perfect in paradise, of course. To be truly useful, the iPad really needs a computer — Mac or Windows PC — to sync with. Some of the apps aren’t powerful enough for heavier needs. But it’s all a great step in the right direction. I’m convinced the model that Apple has laid out with the iPad is the future of home computing. I can’t wait to see how it evolves over the next couple of years now that the software developers have it in their hands.

Time will tell if I’m right about the security aspects, but I’m betting the problems with malware, viruses and the like that we see on other platforms will be virtually obliterated with the iPad model. What consumer won’t find that a breath of fresh air?